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2 INTRODUCTION 

The Mirador program lets you monitor computer systems in a distributed environment. It offers easy 

to use and convenient functionality to directly invoke remote methods and to show the result in 

different views such as tables, forms and charts. The program enables you to subscribe to events that 

may occur at any place within different networks. Mirador uses TIBCO Hawk
®
 application 

programming interfaces. 

In order to understand the Mirador program and the way it interacts with the TIBCO Hawk® system, it 

is recommended to be familiar with the concepts of TIBCO Hawk®.     

It is not advisable to use the Mirador program as the sole monitoring and alerting console in a 

production environment. The robust Tibco Hawk® standard applications should primarily be used. The 

Mirador program is a complementary tool that adds great benefit in terms of visualization, debugging 

and testing of the overall monitoring solution. 

The Mirador program cannot be used for creating new Hawk rulebases and schedules or editing 

existing ones.  
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3 USER INTERFACE 

The Mirador program offers a customary structured user interface that has a menu and a toolbar 

located on its top. On the left handed side appears a navigation tree that represents the structure of 

the monitored Hawk environment. Right to that tree you see the detail view of the current selected 

tree node. Some detail views can be pinned in separate dialogs.  
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3.1 APPLICATION CONTROLS 

3.1.1 MAIN MENU 

The main menu is composed by sub menus and menu items as described below. 

Submenu / Menu Item Description 

File  

   Show Application tǊƻǇŜǊǘƛŜǎΧ Displays the dialog with the application properties that lets 
the user customize the Mirador program. 

   5ƻŎǳƳŜƴǘ !ƎŜƴǘǎΧ 5ƛǎǇƭŀȅǎ ǘƘŜ ά5ƻŎǳƳŜƴǘ !ƎŜƴǘǎέ ŘƛŀƭƻƎ ǘƘŀǘ ƭŜǘǎ ǘƘŜ ǳǎŜǊ 
document the Hawk agents (supported output formats are 
PDF, XLS and HTML). 

   {ŀǾŜΧ 

 

Saves the current state of the Mirador session (not its view 
and microagent method subscriptions) to the mirador.hmo  
ŦƛƭŜ ƭƻŎŀǘŜŘ ƛƴ ǘƘŜ Ψbin Ω ŦƻƭŘŜǊ ƻŦ ǘƘŜ aƛǊŀŘƻǊ ƛƴǎǘŀƭƭŀǘƛƻƴ 
directory. The previous version of the mirador.hmo  file 
ƎŜǘǎ ŎƻǇƛŜŘ ǘƻ ǘƘŜ Ψbin /backup Ω ŦƻƭŘŜǊ ǿƛǘƘ ŀ ƴŀƳŜ ƻŦ ǘƘŜ 

format <yyyy MMddHHmmss>- mirador.hmo . 

The save button has to be pressed each time you change the 
application properties, otherwise these changes will be lost if 
you exit the Mirador program.       

  Exit Stops running the Mirador program. Prior to close the main 
window, you are asked whether you want to save the current 
ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ LŦ ȅƻǳ ŎƻƴŦƛǊƳ ōȅ ǇǊŜǎǎƛƴƎ ǘƘŜ ά¸Ŝǎέ ōǳǘǘƻƴΣ the 
same function gets performed as if you had selected the 
menu item CƛƭŜ Ҕ {ŀǾŜΧ   

View  

   Go To Previous Selection Moves to the previous node from the node selection history. 

   Go To Next Selection Moves to the next node from the node selection history. This 
ōǳǘǘƻƴ ƛǎ ŜƴŀōƭŜŘ ƻƴƭȅ ƛƴ ŎŀǎŜ ǘƘŜ άtǊŜǾƛƻǳǎέ ōǳǘǘƻƴ ǿŀǎ 
pressed before. As soon as the user actively selects a new 
node, ƛǘ ƎŜǘǎ ŀŘŘŜŘ ǘƻ ǘƘŜ ǎŜƭŜŎǘƛƻƴ ƘƛǎǘƻǊȅ ŀƴŘ ǘƘŜ άbŜȄǘέ 
button gets disabled. 



User Manual Mirador Release 2.0 

 

 copyright  centeractive ag Page 7 of 58 

 

Submenu / Menu Item Description 

  {ŀǾŜ /ǳǊǊŜƴǘ ±ƛŜǿΧ Lets the user save the current view to a file for later use. The 
user can himself determine the location and the name of the 
file. The program by default proposes to store the view file in 
the Ψexport/views Ψ folder. The default file extension is 

Ψ.mvwΨ.  

When the current view is saved to a file, the Mirador program 
collects the below listed items and writes them in XML format 
to the chosen file.  

 All agent collection microagents 

 Current active subscriptions 

 All pinned dialogs 

Such a persistent view definition can be reloaded during the 
same session or during any other Mirador session later on 
όǎŜŜ ƳŜƴǳ ƛǘŜƳ ά[ƻŀŘ ±ƛŜǿΧέ ōŜƭƻǿύΦ  

  [ƻŀŘ ±ƛŜǿΧ Lets you choose a view definition file and reloads it. Such a 
view file must have been saved at some point before through 
ǘƘŜ ƳŜƴǳ ƛǘŜƳ ά{ŀǾŜ /ǳǊǊŜƴǘ ±ƛŜǿΧέ ŘŜǎŎǊƛōŜŘ ŀōƻǾŜΦ 

 

The view definition file should have been saved from within 
the same Hawk environment; otherwise the microagent 
method subscriptions and pinned dialogs cannot be re-
created.    

Environment 

   

¢ƘŜ ά9ƴǾƛǊƻƴƳŜƴǘέ sub menu shows all Hawk environments 
configured within the Mirador program.  

  <Environment 1> 

  <Environment 2> 

  <Environment n> 

New environments can be added and existing ones can be 
ŎƘŀƴƎŜŘ ƛƴ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ǇǊƻǇŜǊǘƛŜǎ ŘƛŀƭƻƎ όάIŀǿƪ 
9ƴǾƛǊƻƴƳŜƴǘǎέ ǇŀƴŜƭύΦ ¢ƘŜ ŎǳǊǊŜƴǘ ǎŜƭŜŎǘŜŘ ŜƴǾƛǊƻƴƳŜƴǘ ƛǎ 
marked by the symbol ΨVΩ. The environment can be switched 
only if monitoring is not running. 

Monitoring  

   Run Starts monitoring the current selected Hawk environment 

   Stop Stops monitoring the current selected Hawk environment 

   Enable Discovering New Agents Enables discovering of new Hawk agents. As long as no agents 
appear in the Hawk environment tree, discovering new 
agents is implicitly enabled.  

Enabling discovering new agents does not actively try to 
discover running agents. It would rather only discover agents 
that start running from this moment on. 

   Disable Discovering New Agents Disables discovering of new Hawk agents. This would still 
discover Hawk agents that appear in the navigation tree but 
were not yet discovered in the current session.   

Subscriptions ¢ƘŜ ά{ǳōǎŎǊƛǇǘƛƻƴsέ sub menu contains menu items related to 
Hawk microagent method subscriptions. 
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Submenu / Menu Item Description 

  <Microagent method path 1> 

  <Microagent method path 2> 

  <Microagent method path n> 

This is a dynamic list of tree paths to microagent methods 
that have an active subscription. If a microagent has more 
than one active subscription, it only appears once in the list. 
The unix like tree paths start with the name of the cluster 
followed by the agent and every dependent node name down 
to the final microagent method name, each of these names 
ǎŜǇŀǊŀǘŜŘ ōȅ ŀ ǎƭŀǎƘ όΨκΩύΦ !ƴ ŜȄŀƳǇƭŜ ƻŦ ǎǳŎƘ ŀ ǘǊŜŜ ǇŀǘƘ 
could be the one below: 

   άTEST-CLUSTER/tst0034/Microagents/Self/getUpTimeέΦ 

If the current selected tree node is a microagent method 
node with that has one or several subscriptions, its path 
within the list is marked by the symbol ΨVΩ. 

  Save SubscriptionsΧ Saves all microagent method subscriptions from one agent to 
a file. The user has to select the agent of his choice from a 
dialog and he can freely choose the name of the target file. 
The program by default proposes to store the subscription 
ŘŜŦƛƴƛǘƛƻƴ ŦƛƭŜ ƛƴ ǘƘŜ Ψexport/ subscriptions Ψ ŦƻƭŘŜǊΦ 
¢ƘŜ ŘŜŦŀǳƭǘ ŦƛƭŜ ŜȄǘŜƴǎƛƻƴ ƛǎ Ψ. subΨΦ 

Saved subscription definitions can easily be loaded to the 
same agent or any other agent during the same Mirador 
session or during subsequent session όǎŜŜ ƳŜƴǳ ƛǘŜƳ ά[ƻŀŘ 
Subscriptions Χέ ōŜƭƻǿύΦ 

  Load SubscriptionsΧ Loads microagent method subscriptions from a file on to one 
or several agent and starts them. The user can choose the 
target agents from within a dialog. The subscriptions on these 
agents will be created only if the corresponding microagent 
method can be found there. 

  Stop All Subscriptions Stops all active microagent method subscriptions  

Tool  

  Clean Up GUI Resources Cleans up GUI resources that are currently not visible and not 
active anymore. This may significantly free up memory. Result 
charts and tables as well as specific node settings will be lost. 

   Pin In Independent Dialog Pins the current detail view or part of it (i.e. a tabbed panel) 
in an independent dialog that remains open even if another 
node gets selected in the Hawk environment tree. This 
function is available for the agent overview of the cluster 
nodes and for the subscription panels of microagent method 
nodes.   

Help   

   Mirador HelpΧ 

 

This shows the Mirador user manual in a browser window. 

  Show System PropertiesΧ 

 

Shows an independent dialog and displays the current system 
properties 

  About Mirador 5ƛǎǇƭŀȅǎ ǘƘŜ ά!ōƻǳǘέ ŘƛŀƭƻƎ ƻŦ ǘƘŜ aƛǊŀŘƻǊ ǇǊƻƎǊŀƳΦ 
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3.1.2 MAIN TOOLBAR 

The main toolbar contains a number of buttons that are basically shortcuts to menu items; they are 

explained in the table below 

Button Shortcut to Menu Item 

  CƛƭŜ Ҕ {ŀǾŜΧ 

  View > Go To Previous Selection 

  View > Go To Next Selection 

  Monitoring > Run 

  Monitoring > Stop 

  Monitoring > Enable Discovering New Agents 

  Monitoring > Enable Discovering New Agents 

  Tool > Pin In Independent Dialog 

  Tool > {Ƙƻǿ {ȅǎǘŜƳ tǊƻǇŜǊǘƛŜǎΧ 

 CƛƭŜ Ҕ 5ƻŎǳƳŜƴǘ !ƎŜƴǘǎΧ 

  Help > Mirador Help 
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3.2 TREE NODES 

This section explains the different tree nodes in detail. The following table gives an overview of the 

icons that get used in the left located navigation tree to represent single nodes. 

Icon Description 

 Hawk Environment This is a top level node that corresponds to the Hawk environment 

ǘƘŀǘΩǎ ōŜƛƴƎ ƳƻƴƛǘƻǊŜŘ. The node appears red colored () in case 
there are non-dismissed console warnings present in its detail view. 

 

Icon Annotations 
 

 One or several agents within the monitored Hawk 
environment have at least one open (not cleared) 
notification. 

 One or several agents within the monitored Hawk 
environment have at least one open warning. There may be 
open notifications as well. 

 One or several agents within the monitored Hawk 
environment have at least one open error. There may be 
open warnings and/or notifications as well. 

 

 Agent Collection This node contains structured agent collection microagents. Such 
microagents are inbuilt components that invoke multiple identical 
microagents on different Hawk agents and present all results within 
a single table. The άAgent Collectorέ node only appears if one agent 
collection microagent at least has been defined by the user.     

 Cluster Node Cluster nodes are containers that group a series of agent nodes. The 
cluster name can be configured on each Hawk agent (please consult 
the Hawk documentation). The cluster node shows a number right 
to its name, enclosed in parentheses. This number reports the 
number of agent nodes that are contained within that cluster node.     

 

Icon Annotations 
 

 One or several agents within the cluster have at least one 
open (not cleared) notification. 

 One or several agents within the cluster have at least one 
open warning. There may be open notifications as well. 

 One or several agents within the cluster have at least one 
open error. There may be open warnings and/or 
notifications as well. 
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Icon Description 

 Agent Node (inactive) This node represents a non-detected or inactive Hawk agent. 

 

Icon Annotations 
 

 The agent is known by the Mirador software because it was 
detected when the Hawk environment got monitored in a 
previous session. Currently the status of the agent is 
unknown; it may not yet have been detected or it may not 
be running at all. 

 The agent was detected during the current monitoring 
session but got reported as expired. 

 

 Agent Node (active) This node represents a detected and active Hawk agent. 

 

Icon Annotations 
 

 One or several agents within the cluster have open (non- 
cleared) notifications. 

 One or several agents within the cluster have open warnings 
and maybe notifications. 

 One or several agents within the cluster have open errors 
and maybe warnings and/or notifications. 

 

 Rulebase Engine The rulebase engine contains all schedules and rulebases deployed 
on the agent it belongs to 

 Schedules Shows the schedules that can be used for determining if a rulebase 
or part of the rulebase should be 'in-schedule' or 'out-of-schedule' at 
a given time. 

 Rulebase A single rulebase is shown through this icon 

 

Icon Annotations 
 

 There exist open (not yet cleared) notifications issued by the 
rulebase. 

 There exist open warnings and maybe notifications issued by 
the rulebase. 

 There exist open errors and maybe warnings and/or 
notifications issued by the rulebase 

 

 Microagent Group Microagents are placed in a group node that is named 
άaƛŎǊƻŀƎŜƴǘǎέ ōȅ default. Depending on the application options and 
the name of the microagent, it gets placed inside a different group 
node that is created on the fly. 
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Icon Description 

 Microagent Each agent has a set of microagents that are represented like this 

and placed within a group node ( ) or a branch of group nodes. 
Microagents can also appear underneath the inbuilt Mirador pseudo 
agent in case they are successfully loaded from the Mirador plugin 
directory.  

 

The user can also define agent collection microagents that are based 
on existing microagent found on any remote agent. Such 

ƳƛŎǊƻŀƎŜƴǘǎ ŀǊŜ ǇƭŀŎŜŘ ǿƛǘƘƛƴ ǘƘŜ ά!ƎŜƴǘ /ƻƭƭŜŎǘƛƻƴέ ƴƻŘŜ ό) 
that appears as soon as the first agent collection microagents is 
defined. 

 

Icon Annotations 
 

 The microagent description could not be retrieved from the 
agent 

 

 Method Group Microagent method nodes are placed directly underneath the 
owning microagent node. Depending on the application options and 
the name of the method, it may be placed inside a method group 
node that is created on the fly. 

 Read Method  This icon stands for a read-only microagent method  

 

Icon Annotation 
 

 There is at least one subscription active on that method 
 

 Write Method This icon stands for a write microagent method, a method that has 
an impact ŀƎŜƴǘΩǎ side. 

 

Icon Annotation 
 

 There is at least one subscription active on that method 
 

 Read/Write Method Read-write microagent methods are represented by this icon. 

 

Icon Annotation 
 

 There is at least one subscription active on that method 
 

 Mirador Agent This top level node represents the internal Mirador agent that acts 
like a pseudo Hawk agent in the way that it is able to load Hawk 
ƳƛŎǊƻŀƎŜƴǘǎ ǇǊŜǎŜƴǘ ƛƴ ǘƘŜ ŘƛǊŜŎǘƻǊȅ ƴŀƳŜŘ άpluginέ. If no 
microagent is present or if none of them can be loaded, this node 
does not appear in the tree.   

 

  



User Manual Mirador Release 2.0 

 

 copyright  centeractive ag Page 13 of 58 

 

The following nodes are related to BusinessWorks process engine monitoring. They will appear only in 

case BusinessWorks process engine microagents are present on one or several Hawk agent within the 

monitored environment.  

Icon Description 

 BusinessWorks Engines This folder node contains one or several BusinessWorks (BW) 
process engine nods. Mirador offers a specialized view on BW 
engines and allows user-friendly access of their data.   

 BusinessWorks Engine This node represents a single BW process engine. The node name 
corresponds to the deployment name. BW process engine nodes 

appear directly underneath the  folder node. 

 Process Definition Folder This folder node is used to hierarchically structure the process 
definitions contained in a BW process engine.   

 Starter Process Definition This node represents a process definition that is directly linked to a 
process starter 

 Process Definition This node represents a process definition 

3.2.1 HAWK ENVIRONMENT NODE 

 The top most tree node represents the Hawk environment that is going to be or is already being 

monitored by the Mirador program. The environment can be changed by selecting a different item 

from within the Environment menu. That menu shows all the environments that got defined in the 

application properties dialog. Changing the environment is possible only if the monitoring session is 

not running.  

The Hawk environment node is responsible for the communication with the Hawk system against 

which it maintains event listeners. It delegates detected events to depending nodes (i.e. agent node), 

which in turn change their appearance to show the new state.      

¢ƘŜ ŘŜǘŀƛƭ ǾƛŜǿ ƻŦ ǘƘŜ ŜƴǾƛǊƻƴƳŜƴǘ ƴƻŘŜ Ŏƻƴǘŀƛƴǎ ǘǿƻ ǘŀōǎ ƴŀƳŜŘ ά!ƭƭ !ƭŜǊǘǎέ ŀƴŘ ά/ƻƴǎƻƭŜ 

²ŀǊƴƛƴƎǎέ ǊŜǎǇŜŎǘƛǾŜƭȅΦ 

3.2.1.1 ALL ALERTS 

The άAll Alertsέ ǘŀō ǎƘƻǿǎ ŀ ǘŀōƭŜ ǘƘŀǘ Ŏƻƴǘŀƛƴǎ ǘƘŜ ǿƘƻƭŜ ǎŜǘ ƻŦ ŀƭŜǊǘǎ ǊŜǇƻǊǘŜŘ ōȅ ŀƭƭ ŀƎŜƴǘǎ ƻŦ ǘƘŜ 

current monitored Hawk environment. The details of an alert are shown within a panel below the 

table as soon as an alert row gets selected by the user. A detailed description of this panel can be 

found in the chapter ǘƛǘƭŜŘ ά!ƭŜǊǘ ¢ŀōƭŜ tŀƴŜƭέΦ 

. 
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3.2.1.2 CONSOLE WARNINGS 

¢ƘŜ ά/ƻƴǎƻƭŜ ²ŀǊƴƛƴƎǎέ Ŏƻƴǘŀƛƴǎ ŀ ǘŀōƭŜ ǘƘŀǘ Ŏƻƴǘŀƛƴǎ ǿŀǊƴƛƴƎǎ ƛǎǎǳŜŘ ōȅ ǘƘŜ ǳƴŘŜǊƭȅƛƴƎ Iŀǿƪ 

console. Such warnings report some unexpected events that happened while monitoring a Hawk 

environment. Such a warning would appear if you unplug the network cable from the computer that 

is running the Mirador program. Warnings remain in the table until they get actively dismissed by 

pressing the  button located top right of the table. The top level Hawk environment node in the 

navigation tree is shown with red colour ( ) in case the table contains non dismissed console 

warnings.  
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3.2.2 CLUSTER NODE 

 Cluster nodes are containers that group a series of agent nodes. Every Hawk agent belongs to a 

cluster whose name can freely be configured (please consult the Hawk documentation). The default 

cluster name of an agent is the IP subnet address its host computer is in. All agents with the same 

cluster name are shown within the same cluster node. New cluster nodes get created upon agent 

detection if no other agent with the same cluster name was detected before. Cluster nodes disappear 

if their last agent node gets removed by the user. 

The detail view of the cluster node represents all contained agents in form of an icon representing a 

computer. These icons are of different style and colour depending on the status of the agent they 

represent. If a mouse click occurs on one of these icons, the corresponding agent node gets selected 

in the project tree and the agent detail view will show up.  

The detail view can be detached from its default 

location and be shown in an independent dialog 

(see example on the right) by selecting the menu 

item Tool > Pin Detail View In Independent 

Dialog. The same action can be triggered by 

pressing the  button from the main toolbar. 

This convenient feature lets you quickly move to 

the detail view of different agents or it can be 

placed outside the Mirador main window in 

order to constantly show the health status of the whole cluster. 

The following table lists the different types of icons an agent can be shown with: 

Icon Status Description 

 

Unknown The Mirador program did not detect any event from this agent yet, its 
status is unknown. This icon gets used if the represented structure of a 
monitored Hawk environment was built during the previous monitoring 
session or it got loaded from a previously stored session.  

 

OK The agent is alive and there is no open notification, warning or error 

 

Notice The agent is alive but it reports at least one open notification (no warnings 
nor errors) 

 

Warning The agent is alive but it reports at least one open warning but no errors. 
There may also be open notifications. 
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Icon Status Description 

 

Error The agent is alive but it reports at least one open error. There may also be 
open notifications and warnings. 

 

Expired ¢ƘŜ ŀƎŜƴǘ ŘƻŜǎƴΩǘ ǎŜƴŘ ƘŜŀǊǘ ōŜŀǘǎ ŀƴȅƳƻǊŜΦ ¢ƘŜ ŀƎŜƴǘ ƛǎ ƴƻǘ ǊǳƴƴƛƴƎ 
anymore or there is a problem with the network connection. 

3.2.3 AGENT NODE 

 Agent nodes in the tree are represented by an electric bulb. If the bulb looks like being switched 

on, the Mirador program still receives heartbeat messages that indicate that the agent is alive. If the 

bulb is switched off ( ), the agent state is unknown because no heartbeat messages are received 

anymore. The agent or even its host computer may not be running anymore or there may be a 

problem with the network connection.  

The detail view of the agent node shows a table with notifications and alerts issued by the agent. 

3.2.4 RULEBASE ENGINE NODE 

 This node contains all rulebases deployed on the agent it belongs to. When an agent is newly 

detected, its rulebases are not known immediately but their existence gets announced through 

notification events. Therefore the rulebase repository node gets dependent rulebase nodes added 

slightly after agent discovery only. Some agents do not have any rulebases installed, hence the 

rulebase repository node will not contain any rulebases.  

3.2.5 SCHEDULES NODE 

  Schedules can be used for determining if a rulebase or part of the rulebase should be 'in-schedule' 

or 'out-of-schedule' at a given time. If a schedule is not specified in a rulebase, then the rulebase is 

always in-schedule. 

3.2.6 RULEBASE NODE 

 Every rulebase installed on an agent gets represented by such a node, optionally decorated with a 

small icon that represents the status of the rulebase. The detail view of a selected rulebase node 

shows a detailed description of it. You cannot create new rulebases or change existing ones through 

the Mirador program.  
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The example below shows the detail view of the Hawk standard rulebase HawkWindowsEventLog.  
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3.2.7 MICROAGENT GROUP NODE 

 This tree node groups microagents depending on their display name. The name of the default 

ƎǊƻǳǇ ƴƻŘŜ ƛǎ άaƛŎǊƻŀƎŜƴǘǎέΦ ¢ƘŜ aƛǊŀŘƻǊ ǇǊƻƎǊŀƳ by default checks for colons, commas, dots and 

slashes in the microagent display name and uses them as separator to build up a group node 

hierarchy. ¢ƘŜǊŜŦƻǊŜ ŎŜǊǘŀƛƴ ƳƛŎǊƻŀƎŜƴǘǎ ŀǊŜ ƴƻǘ ǇƭŀŎŜŘ ƛƴ ǘƘŜ άaƛŎǊƻŀƎŜƴǘǎέ ƎǊƻǳǇ ōǳǘ ƛƴ ŀ ǎǇŜŎƛŦƛŎ 

node or branchΦ LŦ ǘƘŜ ƎŜƴŜǊŀǘŜŘ ƎǊƻǳǇ ƴŀƳŜǎ ŀǊŜ ƻŦ ǘƘŜ άғƴŀƳŜҔҐғǾŀƭǳŜҔέ ŦƻǊƳŀǘΣ ƻƴƭȅ ǘƘŜ ǾŀƭǳŜ 

part is shown by default.  

¢ƘŜ ƳƛŎǊƻŀƎŜƴǘ ǿƛǘƘ ǘƘŜ ŘƛǎǇƭŀȅ ƴŀƳŜ άSample:env=test,release=3.2.6,name=Cleanerέ ŦƻǊ ŜȄŀƳǇƭŜ 

would be represented as follows: 

 

Keep in mind that the group node provides a structured view on non-structured entities. All 

microagents directly depend on an agent node; hence logically they are all on the same hierarchy 

level. 

The separators to be used to split microagent names into group names and the decision to partially 

ōƭŀƴƪ ƻǳǘ ǘƘŜ ƎǊƻǳǇ ƴŀƳŜ Ŏŀƴ ōŜ ŎƘŀƴƎŜŘ ƛƴ ǘƘŜ άaƛŎǊƻaƎŜƴǘǎέ ǇŀƴŜƭ ƻŦ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ǇǊƻǇŜǊǘƛŜǎ 

dialog. To display the dialog, select the menu item CƛƭŜ Ҕ {Ƙƻǿ !ǇǇƭƛŎŀǘƛƻƴ tǊƻǇŜǊǘƛŜǎΧ.  

3.2.8 MICROAGENT NODE 

 The microagent node contains a logical group of methods shown as individual nodes each. 

The detail view of the microagent node shows a tabbed pane with a description panel that contains 

the name and description of the microagent. For some microagents the detail view contains an 

ŀŘŘƛǘƛƻƴŀƭ ǘŀō ƴŀƳŜŘ ά!ǘǘǊƛōǳǘŜǎέ ǘƘŀǘ ƭŜǘǎ ȅƻǳ ǾƛŜǿ ŀƴŘ ŜŘƛǘ ŀǘǘǊƛōǳǘŜǎ in a quick mode. Closely 

considered, microagents do not know about a concept of attributes but they expose methods that 

may be used for reading and writing an attributes value, the attribute accessor methods. This concept 

is based on the properties accessor methods described in the JavaBeans API specification (see 

http://java.sun.com/products/javabeans/docs/spec.html). Mirador analyses all methods of a 

ƳƛŎǊƻŀƎŜƴǘ ŀƴŘ ǇǊƻǾƛŘŜǎ ŀ ŦƛŜƭŘ ƻƴ ǘƘŜ ά!ǘǘǊƛōǳǘŜǎέ ǇŀƴŜƭ ƛƴ case a method is considered to be an 

attribute getter method. If for that same attribute there is also a setter method, the field is made 

editable and its background color is changed to white. Methods with a name that start with _get or 

_set can also be accessor methods, the underscore is used by Tibco to mark attribute accessor 

methods in certain products that extend Hawk standard functionality. 

¢ƘŜ ǾŀƭǳŜǎ ƻƴ ǘƘŜ ά!ǘǘǊƛōǳǘŜέ ǇŀƴŜƭ ƎŜǘ ǊŜǘǊƛŜǾŜŘ ŦǊƻƳ ǘƘŜ ŎƻǊǊŜǎǇƻƴŘƛƴƎ ƳƛŎǊƻŀƎŜƴǘ ƳŜǘƘƻŘǎ ǿƘŜƴ 

the microagent node gets selected the first time and each time the node gets selected again. If you 

want to refresh the values while the node selection remains unchanged, you have to press the refresh 

button  located top right on the panel.  

http://java.sun.com/products/javabeans/docs/spec.html
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The following figure shows a sample ά!ǘǘǊƛōǳǘŜέ panel that contains fields for three attributes, two of 

ǘƘŜƳ όΨ5ŜǎŎǊƛǇǘƛƻƴΩ ŀƴŘ ΨbŀƳŜΩύ ŀǊŜ ŜŘƛǘŀōƭŜΦ ¢ƘŜ ōŀŎƪƎǊƻǳƴŘ ŎƻƭƻǊ ƻŦ ǘƘŜ Ψ5ŜǎŎǊƛǇǘƛƻƴΩ ŀǘǘǊƛōǳǘŜ ŦƛŜƭŘ 

is gray because it contains multi line text that cannot be edited in the single line field directly but must 

be edited in a dialog that pops up if a mouse click occurs on the field or the edit button  that 

appears right to it. 

 

3.2.9 MICROAGENT METHOD GROUP NODE 

 This tree node optionally groups microagent methods depending on their name. The Mirador 

program by default does not do any method structuring by default. Depending on the user 

preferences the program checks for certain characters in the method name and uses them as 

separator to build up a group node hierarchy. Therefore certain microagent methods are not placed 

directly underneath the owning microagent node but within a group node or even a branch of group 

nodes.  

¢ƘŜ ƳƛŎǊƻŀƎŜƴǘ ƳŜǘƘƻŘ ǿƛǘƘ ǘƘŜ ƴŀƳŜ άmgmt/mib-2/interfaces/getIfTableέ ŦƻǊ ŜȄŀƳǇƭŜ would be 

represented as follows: 
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Keep in mind that the group node provides a structured view on non-structured entities. All 

microagents methods directly depend on an microagent node; hence logically they are all on the 

same hierarchy level. 

The separators to be used to split microagent method names into group names can be changed in the 

άaƛŎǊƻŀƎŜƴǘǎέ ǇŀƴŜƭ ƻŦ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ǇǊƻǇŜǊǘƛŜǎ ŘƛŀƭƻƎΦ ¢ƻ ŘƛǎǇƭŀȅ ǘƘŜ ŘƛŀƭƻƎΣ ǎŜƭŜŎǘ ǘƘŜ ƳŜƴǳ ƛǘŜƳ 

CƛƭŜ Ҕ {Ƙƻǿ !ǇǇƭƛŎŀǘƛƻƴ tǊƻǇŜǊǘƛŜǎΧ.  

3.2.10 MICROAGENT METHOD NODE 

Micoragent methods may expect arguments (parameters) provided by the user and may return data 

as the result of the method invocation. Methods are named synchronous if they can directly be 

invoked through the Mirador program. Asynchronous methods on the other hand are invoked by the 

Hawk environment if a certain event occurs. To have asynchronous methods interact with the 

Mirador program, the user must subscribe to them. You can also subscribe to synchronous methods 

by providing a time interval, this instructs the Hawk environment to invoke and re-invoke that 

method as long as the subscription exists.  

There exist special types of microagents where the Mirador program itself orchestrates synchronous 

subscriptions. Such microagents are the ones that get loaded locally on to the inbuilt pseudo agent 

but also the so called agent collection microagents that are used to collect data from microagents 

fond on different remote agents.    

  



User Manual Mirador Release 2.0 

 

 copyright  centeractive ag Page 21 of 58 

 

The microagent method nodes are represented by different icons depending of their impact.  

Icon - Impact Description 

 Synchronous Info This is a synchronous άǊŜŀŘ ƻƴƭȅέ ƳŜǘƘƻŘ ǘƘŀǘ ƻƴƭȅ ǇǊƻǾƛŘŜǎ ƛƴŦƻǊƳŀǘƛƻƴ 
without provoking any action or changing any data.  

Icon Annotations 

 This annotation indicates that there exist one or several active 
subscriptions on this method. 

 

 Asynchronous Info This is an asynchronous method that provides information when a 
certain event occurs.  

Icon Annotations 

 This annotation indicates that there exist one or several active 
subscriptions on this method. 

 

 Action This method type does not return any data but provokes an action on 
the target agent. Such actions can be the execution of a script, 
modification of some data etc.  

Icon Annotations 

 This annotation indicates that there exist one or several active 
subscriptions on this method. 

 

 Action-Info This method type provokes an action on the target agent and returns 
some data related to that action.  

Icon Annotations 

 This annotation indicates that there exist one or several active 
subscriptions on this method. 

 

The microagent detail view bȅ ŘŜŦŀǳƭǘ Ŏƻƴǘŀƛƴǎ ǘƘŜ ǘǿƻ ǘŀōōŜŘ ǇŀƴŜƭǎ άLƴǾƻŎŀǘƛƻƴέ ŀƴŘ ά5ŜǎŎǊƛǇǘƛƻƴέΦ 

!ŘŘƛǘƛƻƴŀƭ ǘŀōōŜŘ ά{ǳōǎŎǊƛǇǘƛƻƴέ ǇŀƴŜƭǎ ŀǊŜ ŀŘŘŜŘ ŜŀŎƘ ǘƛƳŜ ȅƻǳ ǎǳōǎŎǊƛōŜ ǘƻ ŀ ƳŜǘƘƻŘ within the 

άLƴǾƻŎŀǘƛƻƴέ ǇŀƴŜƭ. 
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The ά5ŜǎŎǊƛǇǘƛƻƴέ ǇŀƴŜƭ ǎƘƻǿǎ ŀ ŘŜǘŀƛƭŜŘ ŘŜǎŎǊƛǇǘƛƻƴ ƻŦ ǘƘŜ ƳŜǘƘƻŘΣ ŦǊƻƳ ƛǘǎ ŀǊƎǳƳŜƴǘǎ ŀƴŘ ŦǊƻƳ ǘƘŜ 

expected result. 
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¢ƘŜ άLƴǾƻŎŀǘƛƻƴέ ǇŀƴŜƭ ǊŜǇǊŜǎŜƴǘǎ ǘƘŜ Ƴŀƛƴ ǳǎŜǊ ƛƴǘŜǊŦŀŎŜ ǘƻ ƛƴǘŜǊŀŎǘ ǿƛǘƘ ǘƘŜ Iŀǿƪ ŀƎŜƴǘǎ ƻƴ 

remote hosts. 
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.ƻǘƘ άLƴǾƻŎŀǘƛƻƴέ ŀƴŘ ά{ǳōǎŎǊƛǇǘƛƻƴέ ǇŀƴŜƭǎ ƘŀǾŜ ǘƘŜ ǎŀƳŜ ǘƻƻƭōŀǊ ŀǇǇŜŀǊƛƴƎ ǊƛƎƘǘ ƻƴ top of them. 

The individual buttons are described in the following table. 

Button Description 

 Show Result in Form Shows the current and future result data within the same panel in 
a form. This button does only appear if the result is of composite 
data structure.   

 Show Result as HTML Table Shows the current and future result data within the same panel as 
an HTML formatted table. This button appears only if the result 
data is of composite data that by default gets displayed in form.  

 Create Agent Collection 
Microagent Method 

This creates a collection microagent that is based on the current 
selected microagent method. The collection microagent is a 
Mirador software component that appears as a tree node within 

the ά!ƎŜƴǘ /ƻƭƭŜŎǘƛƻƴέ ƴƻŘŜ όύΦ ¢ƘŜ ά!ƎŜƴǘ /ƻƭƭŜŎǘƛƻƴέ ƴƻŘŜ 
itself becomes visible only as soon as the first collection 
microagent has been defined.  

 Invoke Invokes the microagent method with the argument values (if any) 
entered by the user and displays the result unless the method 
ƛƳǇŀŎǘ ƛǎ ƻŦ ǘȅǇŜ ά!ŎǘƛƻƴέΦ 

 Subscribe Subscribes to the microagent 
method. In case of a synchronous 
method, the user has to enter the 
method invocation interval within 
the pop up dialog shown beside. 
Such an interval should be at least 
5 seconds; Hawk agents usually 
ŎŀƴΩǘ ŎƻǇŜ ǿƛǘƘ ǎƳŀƭƭŜǊ ƛƴǘŜǊǾŀƭǎ. 
If the subscription is created on a microagent method from within 
the Mirador agent however, also small intervals (i.e. 1 second) will 
be applied correctly.  

 

Lƴ ƻǊŘŜǊ ǘƻ ŦǊŜŜ ǳǇ ǘƘŜ άLƴǾƻŎŀǘƛƻƴέ ǇŀƴŜƭ ŦƻǊ ƻǘƘŜǊ ƳŜǘƘƻŘ 
invocations or additional subscriptions, an independent 
ά{ǳōǎŎǊƛǇǘƛƻƴέ ǇŀƴŜƭ ƎŜǘǎ ŀŘŘŜŘ ǘƻ ǘƘŜ ŘŜǘŀƛƭ ǾƛŜǿ ƻŦ ǘƘŜ 
microagent method as soon as the subscription is created.  

 

When an agent expires, all subscriptions to its microagent 
methods are terminated. When an expired agent is discovered 
again during the same monitoring session, Mirador automatically 
tries to re-create all the subscriptions that were active when the 
agent expired.    

 Unsubscribe Un-ǎǳōǎŎǊƛōŜǎ ŦǊƻƳ ŀ ƳƛŎǊƻŀƎŜƴǘ ƳŜǘƘƻŘΦ ¢ƘŜ ά{ǳōǎŎǊƛǇǘƛƻƴέ 
panel remains in place after you unsubscribe from a method. On 
that same panel you can subscribe to the method again at any 
time later. LŦ ǘƘŜ ά{ǳōǎŎǊƛǇǘƛƻƴέ ǇŀƴŜƭ ƛǎ ƴƻ ƭƻƴƎŜǊ ǳǎŜŘΣ ȅƻǳ Ŏŀƴ 
remove it by selecting the appropriate menu item from the popup 
menu that appears when you right click on the tab. 
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Button Description 

 Clear Historic Restult Table Removes all rows from the historic result table. This button 
appears only if the historic view can be selected in the context of 
the current panel. Clearing the historic view is useful when you 
have an active method subscription and all previous results from 
that subscription are no longer of any interest.  

 Hide Result Controls IƛŘŜǎ ǘƘŜ ǊŜǎǳƭǘ ŎƻƴǘǊƻƭ ōƻȄ ǘƘŀǘ ŀǇǇŜŀǊǎ ǊƛƎƘǘ ƻƴ ǘƘŜ άLƴǾƻŎŀǘƛƻƴέ 
panel. This frees up space for showing the method result.  

 Show Result Controls Displays the result control ōƻȄ ǊƛƎƘǘ ƻƴ ǘƘŜ άLƴǾƻŎŀǘƛƻƴέ ǇŀƴŜƭ ŀƴŘ 
lets you change the result view. 

3.2.10.1 RESULT VIEW 

Depending on the method, ǘƘŜ άLƴǾƻŎŀǘƛƻƴέ same as ǘƘŜ ά{ǳōǎŎǊƛǇǘƛƻƴέ ǇŀƴŜƭ let you enter method 

arguments and they both display the results from synchronous method invocations and/or 

asynchronous event notifications. The default look of the result view can be changed within the result 

control box ǘƘŀǘ ŀǇǇŜŀǊǎ ǊƛƎƘǘ ƻƴ ǘƘŜ άLƴǾƻŎŀǘƛƻƴέ ŀƴŘ ǘƘŜ ά{ǳōǎŎǊƛǇǘƛƻƴέ panel. The following result 

views can be selected from a combo box within the result control box. 

Result View Description 

Default Depending on whether the method returns individual fields or tabular data, this 
view shows the result in a form or a table according to the following examples 
made with the standard micǊƻŀƎŜƴǘ άtǊƻŎŜǎǎέ. 

Example Method Process. getInstanceCount : This method expects one 
argument and returns two fields. If a result field contains multiple line text data, a 
mouse click on the editor icon behind the field lets you pop up a dialog where you 
can show the data in its full mode.  

 

Example Method Process. getProcess : This also expects one argument 
but returns a table where each row represents a process running on the related 
host. The rows can be sorted by any column by clicking on the corresponding 
column header. Selecting the check box appearing top right of the table will adjust 
its width to the enclosing panel.   
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Result View Description 

 

In order to display the data of a single row in a well-structured format on the 
bottom of the panel, select it. Double click a row to show the row data in a pop up 
dialog that looks similar to the one shown below. 
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Result View Description 
historic Other then the default view, the historic view does not overwrite previous results 

each time a method gets invoked. Up to a certain number of results from different 
method invocations are kept and displayed in a table together with a timestamp. 
The maximal number of retained results can be configured within the 
άaƛŎǊƻŀƎŜƴǘǎέ ǇŀƴŜƭ ƻŦ ǘƘŜ ŀǇǇƭƛŎŀǘƛƻƴ ǇǊƻǇŜǊǘƛŜǎ ŘƛŀƭƻƎ όƳŜƴǳ ƛǘŜƳ File > Show 
!ǇǇƭƛŎŀǘƛƻƴ tǊƻǇŜǊǘƛŜǎΧ).  
 

 
 

The historic view ǘŀōƭŜ Ŏŀƴ ōŜ ǎƻǊǘŜŘ ōȅ ǘƘŜ άwŜǎǳƭǘ ¢ƛƳŜǎǘŀƳǇέ ŎƻƭǳƳƴ ƻƴƭȅΦ  
The historic view is not available for methods that return tabular data by default. 
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Result View Description 

line chart The line chart is available for methods that 
return tabular data where at least one of 
the columns contains numeric data. Within 
the result control box, one of the table 
columns has to be chosen to become the 
label column. The label column makes the 
distinction between categories of data and 
must contain unique values over all table 
rows. If the value of the chosen label 
column is not unique, the label can be 
extended and made unique by the value of 
ŀ ǎŜŎƻƴŘ Ǌƻǿ όά[ŀōŜƭ /ƻƭǳƳƴ нέύΦ One or 
several columns representing numeric data can be selected to be used as the 
value columns, means the data provider.  
 
The lower bound field can be used to explicitly define the lower bound of the 
ŎƘŀǊǘΩǎ ǾŜǊǘƛŎŀƭ ǾŀƭǳŜ ŀȄƛǎΦ  
 
The label orientation can be changed through a slider control. This is useful where 
long labels would otherwise be overlaid.    
 

 
 




























































